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ABOUT THIS GUIDE
The TeaM Server User’s Guide provides information about installing and using Déjà Vu
TeaM Server.

REVISION HISTORY
This guide is revised with each release of the product or when necessary. A revised
version can contain minor or major changes. The following table summarizes the
significant changes in each version of this guide:
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Revision

Description

20100226

First version of the TeaM Server documentation.

To view the most current version of the guide, see the ATRIL Web site:
http://www.atril.com/docs/

INTENDED AUDIENCE
This book is intended for anyone who needs to install, upgrade, configure or use TeaM
Server. TeaM Server users typically work for medium and large translation agencies or
for large multinational companies who have an internal translation department. Users
include IT staff, project managers, reviewers and translators.
The Installing TeaM Server is intended for the IT administrators for installing and
maintain the server hardware and software. The Configuring TeaM Server section is
intended for administrators and project managers. The rest of the sections are intended
for all users of TeaM Server.

DOCUMENT FEEDBACK
ATRIL welcomes your suggestions for improving our documentation. If you have
comments, send your feedback to: support@atril.com

TECHNICAL SUPPORT
This section describes the technical support resources available to you. To access the
most current version of this guide and other documentation, go to:
http://www.atril.com/docs/

ONLINE, E-MAIL AND TELEPHONE SUPPORT
Online support resources are available to all ATRIL customers. For details, go to:
http://support.atril.com/
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E-mail support is available to all ATRIL customers. You can submit technical support
requests to: support@atril.com
Customers with appropriate support contracts should use telephone support for the
fastest response on high priority issues. For contact details, go to:
http://www.atril.com/agents/

REPORTING PROBLEMS
If you have problems while running TeaM Server, report them to the ATRIL support
team. You can report your problems by submitting a support request to:
support@atril.com
You can also submit support requests to your local distributor. For contact details, go to:
http://www.atril.com/agents/
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INTRODUCTION AND SYSTEM REQUIREMENTS
This chapter describes the key product features and benefits of using TeaM Server, and
gives a brief technical overview of the various TeaM Server components. It also
describes the system requirements for operating TeaM Server.

TEAM SERVER OVERVIEW
TeaM Server is a solution for sharing large Translation Memory (TM) and Terminology
Database (TD) repositories both over local area networks (LANs) and across the Internet.
TeaM Server extends the capabilities of Déjà Vu X Workgroup to allow teams of
translators who work on extensive, multilingual and multisite translation projects to
share their translations in real-time.

PRODUCT BENEFITS
Multilingual translation projects are usually assigned to large teams of translators, where
each translator is tasked with translating the source text into his or her target language.
For large projects, especially if there are time constraints involved, the translation into a
single language may also be divided among several translators.
TeaM Server offers a number of features designed to increase the efficiency of large
translation projects.

INCREASED TRANSLATION LEVERAGING
When working on large projects, many of the advantages offered by Computer Assisted
Translation (CAT) tools may be negated by a lack of communication and/or
coordination between the translators working on the same target language.
In particular, even after pre-translating the text against existing TMs, there may be
numerous untranslated duplicate segments which require manual translation. If they are
spread out throughout the text, each translator working on the project will have to
translate at least the first instance of each duplicate segment that appears in the portion
of the text assigned to them, leading to a duplication of efforts and an increase in costs.
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TeaM Server allows translators working on the same projects to immediately see the
translations added by their colleagues, which means that as soon as one instance of a
duplicate segment is translated by one of the members of the team, no other translator
needs to translate the segment again. This can lead to a significant reduction in overall
project costs.

INCREASED CONSISTENCY
In addition to reducing costs, sharing translations between translation team members
can increase consistency. In a large project, there may be a number of instances of
technical terms that are not present in any glossaries or in the TD at the time the project
begins; those terms may be translated differently by each translator that encounters
them.
When using TeaM Server, any new translation of a segment or term is immediately
visible to all other translators connected to the server. Translators therefore have instant
access to newly added terminology, so no term or phrase is translated twice (in possibly
different ways), ensuring maximum consistency.

REMOTE ACCESS
Déjà Vu X Workgroup offers the ability to share TMs and TDs between groups of
translators through the COM+ Server component, but is limited to doing so over local
area networks (LANs). TeaM Server replaces the COM+ Server and adds the ability to
share TMs and TDs not only over a LAN but also through the Internet.
Our optimized remote sharing technology ensures that, whether working in the same
office or across the globe, TeaM Server provides translators with the same advanced
leveraging capabilities of Déjà Vu X Workgroup; all of the translation and QA features of
Déjà Vu X Workgroup (such as Scan, Lookup, Pretranslate, Assemble, AutoSearch,
AutoSend, AutoCheck, etc.) work exactly when connected to a TeaM Server as when
using local TMs and TDs.
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SCALABILITY
TeaM Server provides scalable centralized storage for translation memories and
terminology databases. The size of translation and terminology repositories and the
number of concurrent users is only limited by the server hardware and bandwidth.
Local TMs and TDs in Déjà Vu X Workgroup are limited to 2GB, whereas in TeaM
Server the size is only limited by the available hard disk space, and can grow to
hundreds of GBs.
Even when using the COM+ Server, Déjà Vu X Workgroup is limited to sharing local
TMs and TDs between a small number of users (up to a maximum of 15-20). TeaM
Server allows hundreds of users to share translations in real-time.

SIMPLIFIED LICENSING MODEL
TeaM Server features a simplified licensing model, designed to reduce implementation
costs and administrative complexity. Any license of Déjà Vu X Workgroup acts as a
client access license (CAL) for TeaM Server, meaning that any translator using Déjà Vu X
Workgroup can access the server, without the need to purchase additional CALs.
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TEAM SERVER COMPONENTS
TeaM Server consists of several modular components that can run independently of
each other, except for the database, which is required by all other components.

DATABASE
TeaM Server stores all of its data on a SQL Server database. By using a scalable storage
engine such as SQL Server, TeaM Server can overcome the size and concurrent access
limitations of the local TMs and TDs used in Déjà Vu X Workgroup (which are limited to
2GB per database and a maximum of 10-15 concurrent users per database).
The database can be attached to a SQL Server instance running either on the same
server as the other TeaM Server components, or on a separate server. The TeaM Server
database can coexist on the same SQL Server instance as other databases used by other
software, so you can use the same SQL Server to hosts databases for various programs.

WEB SERVICE
TeaM Server includes a web service component, running on top of Microsoft’s Internet
Information Services (IIS), which exposes the TeaM Server engine over the Internet.
Communication between the client and the server is done using the Simple Object
Access Protocol (SOAP), the industry standard protocol for web services. The SOAP
messages are encoded in XML and routed using the HTTP protocol (the standard Web
protocol), which allows them to be routed through firewalls and proxies without
requiring significant changes to existing network security. By using standard protocols,
TeaM Server also ensures that no additional ports need to be open on client firewalls.

TCP LISTENER
TeaM Server also includes a Windows service that implements a TCP Listener, which
provides access to the TeaM Server engine using the native .NET Framework Binary TCP
remoting protocol.
The TCP Listener does not require communication between the client and the service
to be encoded in XML, so it has considerably less overhead than the HTTP-based web
8

service interface. However, it means that it is not suitable for exposing over the Internet
(since it uses binary protocols and ports that are usually not open on firewalls), so it is
only recommended for those users running on the same LAN as TeaM Server itself.

WEB-BASED ADMINISTRATION CONSOLE
TeaM Server is designed to work as a scalable storage and sharing engine for Déjà Vu X
Workgroup. Most of the features exposed by the TeaM Server engine are used directly
from the Déjà Vu X Workgroup client, but there are a number of administrative tasks
(such as managing user accounts) that cannot be performed on the client-side.
For these tasks, TeaM Server provides a web-based administration console which allows
administrators to manage the Translation Memory (TM) and Terminology Database (TD)
data on the server, as well as the user accounts and permissions.
For more information, please consult the TeaM Server Administration chapter.

SECURITY
When giving remote access to a server over the Internet, security is naturally an
important concern. TeaM Server includes security features that provide both access
control and encryption.

USER PERMISSIONS
TeaM Server allows administrators to control access to the translation and terminology
repositories on the server by granting or denying access to entries based on specific
language and/or client values. Once access has been granted, permission levels for each
language determine whether a user can modify or delete an entry previously added by
another user.
Access control to TeaM Server is managed through the use of role-based security.
Rather than assigning access rights and permission levels directly to each user, and
administrator defines user roles (usually for each type of user who will connect to TeaM
Server), and then assigns a user role to each user account. Since a translator’s role may
change from one project to the next (for example, from translator to reviewer), this
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allows administrators to easily update a user’s access permissions without manually
assigning them at the beginning of every new project.

DATA ENCRYPTION
When a Déjà Vu X Workgroup client connects to TeaM Server, it requests a security
token from the server, which is then used to sign and encrypt all of the client’s requests
to the server during that session. This encryption is applied when using either the SOAP
over HTTP protocol or the Binary TCP protocol. This encryption ensures that any hacker
who might be intercepting network transmission packages cannot read the data being
sent between the client and the server. For additional security, the IIS application for
the Web Service interface can be configured to use the HTTPS protocol (using an SSL
certificate provided by the user).
Access to the web-based administration console is not encrypted by default, since it is
designed to be used only be internal administrators. In the event that access to the
admin console through the Internet is required, the IIS application for the web-based
administration console can be configured to use the HTTPS protocol (using an SSL
certificate provided by the user).
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PLANNING A TEAM SERVER DEPLOYMENT
Before you install TeaM Server, you should identify the deployment scenario that most
closely matches your needs.
TeaM Server requires an installation of Microsoft SQL Server for data storage purposes.
Depending on the number of users who will be connecting to TeaM Server, you can
choose between a single-server deployment, where TeaM Server and SQL Server are
installed on the same server, and a dual-server deployment, where TeaM Server and
SQL Server are installed on separate servers.

SINGLE-SERVER DEPLOYMENT
In a single-server deployment, both TeaM Server and SQL Server are installed on the
same server (physical or virtual). Single-server deployments are therefore self-contained
and offer advantages in terms of backup and recovery procedures, but may affect
scalability, particularly when working with large translation repositories and/or large
numbers of users.

DUAL-SERVER DEPLOYMENT
In a dual-server deployment, the TeaM Server software is installed on one server and
SQL Server is installed on a different server (physical or virtual). Compared with singleserver deployments, dual-server deployments require more complex backup and
recovery procedures, but they offer greater flexibility in terms of scalability. Additionally,
if you have an existing SQL Server installation (especially one that is licensed per
processor), you can use it as the storage server for TeaM Server, thereby saving on the
cost associated with licensing SQL Server.
For further guidance, please consult the Hardware Recommendations section.

11

SYSTEM REQUIREMENTS
To install TeaM Server, your system must meet the operating system requirements
described in this section. Depending on the version of Microsoft SQL Server that you
choose to use with TeaM Server, more restrictive requirements may apply.

OPERATING SYSTEM REQUIREMENTS
You can install TeaM Server on a server that is running one of the following operating
systems:
•
•
•
•

Microsoft Windows Server 2003
Microsoft Windows Server 2003 R2
Microsoft Windows Server 2008
Microsoft Windows Server 2008 R2

You can install TeaM Server on a client computer that is running one of the following
operating systems:
•
•
•

Microsoft XP Professional
Microsoft Windows Vista
Microsoft Windows 7

Note: Client operating systems are limited in the number of incoming connections, and
are therefore only suitable for test deployments or for small teams of translators.
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HARDWARE RECOMMENDATIONS
Depending on the number of users who will be connecting to TeaM Server, you may
require more or less powerful hardware. Additionally, when planning a TeaM Server
deployment to serve a large number of users, it is recommended that you consider
installing TeaM Server and SQL Server on separate servers.
The following table offers some guidelines regarding the recommended hardware for
different numbers of users:
Users

CPU

Disk

Memory

Configuration

1 to 10 users

1 processor, 2.4
GHz

100 GB

2 GB

Single-server (TeaM Server and
SQL Server on the same server)

10 to 20
users

2 processors,
3.6 GHz

250 GB

4 GB

Single-server

20 to 100
users

4 processors,
3.6 GHz

500 GB

8 GB

Dual-server (TeaM Server and
SQL Server on separate servers)

More than
100 users

8 processors,
3.6 GHz

1 TB

16 GB

Dual-server

When working with a dual-server configuration, the recommended hardware
specifications shown above apply to both servers, except for the disk guidelines, which
are only applicable to the machine where SQL Server is installed.
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INSTALLING TEAM SERVER
This chapter describes how to install the software prerequisites for TeaM Server, and
how to install TeaM Server itself.

INSTALLATION PREREQUISITES
This section describes how to install and configure the prerequisite software required for
Team Server.

INSTALLING INTERNET INFORMATION SERVICES
Before you can install TeaM Server, you must install Internet Information Services (IIS)
with the options that the installation procedures specify. After you install IIS, you should
install any recommended updates from Microsoft using Windows Update.
Note: IIS is only required on the server on which TeaM Server will be installed. If you
have opted for a dual-server deployment, you do not need to install IIS on the server
where SQL Server will be installed.

INSTALLING IIS 6.0 ON WINDOWS SERVER 2003
On servers that are running Windows Server 2003 or Windows Server 2003 R2, you
can use Control Panel to install Internet Information Services (IIS) 6.0. In addition to the
default options, you must configure IIS 6.0 with these options:
•
•

ASP.NET must be enabled.
The IIS 5.0 isolation option must not be enabled.

REQUIRED PERMISSIONS
To perform this procedure, you must be a member of the Administrators security
group on the server on which you are installing IIS.
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TO INSTALL IIS ON WINDOWS SERVER 2003
1.
2.
3.
4.
5.
6.

Open Add or Remove Programs from Control Panel.
Click Add/Remove Windows Components.
The Windows Components Wizard starts.
On the Windows Components page, select the Application Server check box,
and then click Details.
If not already selected, select the ASP.NET check box, and then click OK. Do not
change or clear any other currently selected components.
On the Windows Components page, click Next.
Click Finish to close the wizard.

INSTALLING IIS 7.0 ON WINDOWS SERVER 2008
On servers that are running Windows Server 2008, you can use the Server Manager to
install Internet Information Services (IIS) 7.0. In addition to the default options, you
must add the following role services to IIS 7.0:
•
•

ASP.NET
IIS 6.0 Management Compatibility

REQUIRED PERMISSIONS
To perform this procedure, you must be a member of the Administrators security
group on the server on which you are installing IIS.

TO INSTALL IIS ON WINDOWS SERVER 2008
1.
2.
3.
4.

On the server where you intend to install TeaM Server, click Start, point to
Administrative Tools, and then click Server Manager.
In the tree pane, click Roles.
In the details pane, click Add Roles.
The Add Roles Wizard starts.
On the Before You Begin page, read the instructions, and then click Next.
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5.

On the Select Server Roles page, select the Web Server (IIS) check box. If the
Add features required for Web Server (IIS) dialog box appears, click Add
Required Features. Click Next.
6. On the Web Server (IIS) page, read the information, and then click Next.
7. On the Select Role Services page, select the following check boxes (without
changing the other default settings), and then click Next:
•
ASP.NET
If the Add role services and features required for ASP.NET dialog box
appears, click Add Required Role Services.
•
Windows Authentication
•
IIS 6 Management Compatibility
All subordinate check boxes are automatically selected.
8. On the Confirm Installation Selections page, review the installation information.
9. If the information is correct, click Install. To make corrections, click Previous.
10. After the Add Roles Wizard installs IIS, click Close.

INSTALLING SQL SERVER
Before you install TeaM Server, you must install Microsoft SQL Server or have an
existing installation of SQL Server that meets the following requirements:
Supported Editions

•
•

Microsoft SQL Server 2005
Microsoft SQL Server 2008

Collation Settings

•
•
•
•

Must be accent sensitive
Must not be case sensitive
Must not be Binary
Must not be Binary - code point

Authentication

Windows authentication

Service account

You can use a domain account or a built-in account

INSTALLING SQL SERVER 2005
The following instructions will guide you through the process of installing and
configuring the features of SQL Server 2005 Standard or Enterprise Edition required to
16

run TeaM Server. If you intend to use the same SQL Server installation to serve other
applications, you may want to install additional features.

REQUIRED PERMISSIONS
To perform these procedures, you must be a member of the Administrators security
group on the server on which you are installing SQL Server. If you have opted for a
single-server deployment, this will be the same server on which you install TeaM Server.

TO INSTALL SQL SERVER 2005
1.
2.

Log on to Windows using an appropriate account.
Start the installation wizard by inserting the installation DVD for SQL Server 2005
Enterprise Edition or Standard Edition.
The SQL Server 2005 Start page appears.
3. On the SQL Server 2005 Start page, click Server components, tools, Books
Online, and samples.
4. On the End User License Agreement page, review the license agreement. If you
accept the terms and conditions, select the I accept the licensing terms and
conditions check box, and then click Next.
5. On the Installing Prerequisites page, click Install.
6. After the prerequisites are installed, click Next.
The Microsoft SQL Server Installation Wizard starts.
7. Click Next.
8. On the System Configuration Check page, perform any required actions, such as
restarting the server, and then click Next to start installation.
Note: For a dual-server deployment, you can safely ignore the warning about
installing Internet Information Services (IIS) on the server running SQL Server.
9. On the Registration Information page, complete the registration information, and
then click Next.
10. On the Components to Install page, select the check box for SQL Server
Database Services, then click Next.
11. On the Instance Name page, click Default instance or Named instance. If you
click Named instance, type the name of the instance. Click Next.
12. On the Service Account page, click Use the built-in System account or Use a
domain user account. If you click Use the built-in System account, select
Network Service. If you click Use a domain user account, type a domain account
17

13.
14.

15.

16.

17.
18.

and password. In Start services at the end of setup, select the following check
boxes, and then click Next:
•
SQL Server
•
SQL Server Agent
•
SQL Browser
On the Authentication Mode page, click Windows Authentication Mode, and
then click Next.
On the Collation Settings page, select the appropriate collation for the languages
you will be using, and then click Next.
Note: TeaM Server requires certain collation settings. You should select a collation
that is case insensitive, accent sensitive, not binary and preferably width and kana
insensitive.
(Optional.) On the Error and Usage Reporting page, select one or both check
boxes to specify where information about errors and feature usage should be sent,
and then click Next.
On the Ready to Install page, review the list of components to be installed, and
then click Install.
The Setup Progress page shows the installation status of each component.
After installation has completed, click Next.
Click Finish to close the wizard.

INSTALLING SQL SERVER 2008
The following instructions will guide you through the process of installing and
configuring the features of SQL Server 2008 Standard or Enterprise Edition required to
run TeaM Server. If you intend to use the same SQL Server installation to serve other
applications, you may want to install additional features.

REQUIRED PERMISSIONS
To perform these procedures, you must be a member of the Administrators security
group on the server on which you are installing SQL Server. If you have opted for a
single-server deployment, this will be the same server on which you install TeaM Server.
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TO INSTALL SQL SERVER 2008
1.
2.

3.

4.
5.
6.

7.
8.
9.
10.
11.
12.

13.

Log on to Windows using an appropriate account.
Insert the installation DVD for SQL Server 2008 Enterprise Edition or Standard
Edition, and double-click setup.exe.
Note: The installation program for SQL Server offers to install the appropriate
versions of the Microsoft .NET Framework and Windows Installer if they are not
already installed. You must install these components to proceed with the
installation of SQL Server, and you must restart your server when prompted after
these components are installed.
On the SQL Server Installation Center page, click Installation, and then click
New SQL Server stand-alone installation or add features to an existing
installation.
On the Setup Support Rules page, click OK.
On the Product Key page, type your product key.
On the License Terms page, review the license agreement. If you accept the terms
and conditions, select the I accept the licensing terms check box, and then click
Next.
On the Setup Support Files page, click Install.
On the Setup Support Rules page, click Next.
On the Feature Selection page, select the check box for Database Engine
Services, and then click Next.
On the Instance Configuration page, click Default instance or Named instance.
If you click Named instance, type the name of the instance. Click Next.
On the Disk Space Requirements page, click Next.
On the Server Configuration page, click Use the same account for all SQL Server
services, or type the name of a domain account or NT AUTHORITY\NETWORK
SERVICE in Account Name for every service.
•
If you specify a domain account, type its password in Password.
•
If you use NT AUTHORITY\NETWORK SERVICE, leave the Password box
blank.
In the Startup Type column, verify that Automatic appears for all accounts that
you can edit.
In the Collation tab, select the appropriate collation for the language you will be
using, and then click Next.
Note: TeaM Server requires certain collation settings. You should select a collation
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14.
15.

16.
17.

18.
19.
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that is case insensitive, accent sensitive, not binary and preferably width and kana
insensitive.
On the Database Engine Configuration page, click Windows authentication
mode, click Add Current User, and then click Next.
(Optional.) On the Error and Usage Reporting page, select one or both check
boxes to specify where information about errors and feature usage should be sent,
and then click Next.
On the Installation Rules page, click Next.
On the Ready to Install page, review the list of components to be installed, and
then click Install.
The Installation Progress page shows the status of each component.
After installation has completed, click Next.
On the Complete page, click Close.

INSTALLING TEAM SERVER
Before installing TeaM Server, you should ensure that your system meets the
requirements outlined in the System Requirements section, and that the necessary
prerequisites have been installed or configured according to the instructions in the
Installation Prerequisites section.

REQUIRED PERMISSIONS
To perform these procedures, you must be a member of the Administrators security
group on the server on which you are installing TeaM Server. If you are working with a
dual-server deployment, you also need to ensure that you are an SQL Server
Administrator, and that the machine account for the server has logon rights to SQL
Server.

TO INSTALL TEAM SERVER
1.

2.
3.
4.
5.

6.
7.
8.
9.

Start the installation wizard by inserting the installation CD for Déjà Vu TeaM
Server.
The Déjà Vu TeaM Server Start page appears.
On the Déjà Vu TeaM Server Start page, click Install TeaM Server.
The Installation Wizard appears. Click Next.
On the Destination Folder page, you can optionally specify a different destination
folder by clicking on Change.
Click Next.
On the Database Server page, enter the name (and optionally instance name) of
the server where SQL Server is installed. If you are using a single-server
deployment, you can enter (local) as the server name. Alternatively, you can click
Browse to select the SQL Server instance from a list of instances available on your
network.
Select the Windows authentication credentials of current user option, and click
Next.
On the Ready to Install page, click Install.
The Installation Progress page appears.
After installation has completed, click Next.
On the Complete page click Finish.
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CONFIGURING TEAM SERVER
This chapter describes the post-installation configuration steps required to begin using
TeaM Server.

CONFIGURE THE ADMINISTRATOR USER ACCOUNT
Once TeaM Server has been installed, the first step an administrator needs to take is to
log onto the web-based administrative console and change the password for the default
administrator account.

TO CHANGE THE DEFAULT ADMIN PASSWORD
1.

2.
3.
4.
5.
6.
7.
8.
9.

Open the web-based administration console by clicking on Start > All Programs
> Déjà Vu TeaM Server > Web-based Administration Console.
The Logon page appears.
In the Username text box, type: Admin
In the Password text box, type: admin
Click on the Logon button.
The Déjà Vu TeaM Server Management page appears.
Click on the Manage Users link.
The Manage Users page appears.
In the list of users that appears, click on Admin.
The User Detail page appears.
In the New Password text box, type in the new password.
In the Confirm New Password text box, type in the new password.
Click on the Update Details button.

EXPOSING A TEAM SERVER OVER THE INTERNET
If you intend to provide external access to TeaM Server over the Internet, you will need
to configure your corporate firewall and, optionally, the firewall software running on the
server where TeaM Server is installed. Additionally, you may want to configure IIS to
use the HTTPS protocol to encrypt all access to TeaM Server, including the web-based
administration console.
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FIREWALL
The TeaM Server installer will configure the Windows Firewall on the server to allow
incoming traffic for the TCP Listener component. If you are using a different firewall
program on the server, you will need to manually configure the firewall rules to allow
incoming traffic on TCP ports 1845 and 1846 or, alternatively, to allow incoming traffic
for the TCP Listener service executable (installed by default to C:\Program
Files\ATRIL\Déjà Vu TeaM Server\TcpService\Atril.TMServer.Server.Tcp.exe).
If the Windows Firewall was turned on when you installed IIS on the server, Windows
will automatically open TCP ports 80 (HTTP) and 443 (HTTPS) to incoming traffic. If
you are using a different firewall program on the server, you will need to manually
configure the firewall rules to allow incoming traffic on TCP port 80 (and optionally on
TCP port 443 if you want to configure IIS to use HTTPS for additional security).
In order to expose the TeaM Server Web Service interface (and, optionally, the webbased administration console) to external users over the Internet, you will need to
configure your corporate firewall to publish the TeaM Server web server on the Internet,
allowing HTTP access over TCP port 80 (and, optionally, HTTPS access over TCP port
443). Please consult your firewall documentation for further instructions.

HTTPS
All traffic between the Déjà Vu X Workgroup clients and TeaM Server following the WSSecurity standard: when the client first connects to TeaM Server, it requests a security
token that is then used to sign and encrypt all communication between the client and
the server for the duration of the session.
However, for additional security, and to encrypt all access to the web-based
administration console, it is possible to configure IIS on the server running TeaM Server
to only accept connections using the HTTPS protocol. In order to do so, you will need a
valid SSL certificate for the server, and you will need to configure the IIS web site to
accept only HTTPS requests (or to redirect HTTP requests to HTTPS). Please consult
your Windows Server 2003 or 2008 documentation for further instructions.
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TEAM SERVER ADMINISTRATION
This chapter describes how to use the web-based administration console provided by
TeaM Server to carry out administrative tasks.

ADMINISTRATION CONSOLE OVERVIEW
Although TeaM Server is designed to be used primarily from a Déjà Vu X Workgroup
client, there are a number of administrative tasks (such as managing user accounts) that
cannot be performed from Déjà Vu X. To carry out these administrative tasks, TeaM
Server provides a web-based administration console.
The web-based administration console is a web application that runs on IIS. It provides
a number of web pages which allow you manage user roles, user accounts, Translation
Memory (TM) data, Terminology Database (TD) data and attributes, and an overview of
the languages in use by the server.
To use the administration console, you must first log in.
Note: If you are the server administrator and have not logged in before, please follow
the instructions in the Configure the Administrator User Account section to change the
default administrator password.

TO LOG ONTO THE ADMINISTRATION CONSOLE
1.

2.
3.
4.

Open the web-based administration console by clicking on Start > All Programs
> Déjà Vu TeaM Server > Web-based Administration Console, or by navigating
to http://servername/TeaMServer/Admin/ in your browser.
The Logon page appears.
In the Username text box, type your user name.
In the Password text box, type your password.
Click on the Logon button.
The Déjà Vu TeaM Server Management page appears.

From the Déjà Vu TeaM Server Management page, you can access all of the
management modules. The rest of this chapter describes each of the modules in detail.
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USER ROLES
Security in TeaM Server is designed around the concept of user roles. A user role
represents a type of user in your organization. In other words, it corresponds to a user
profile that is applicable to one or more users in your organization (in other words, a
group of users with a common defining characteristic). For example, if your company is
a multinational corporation with an in-house translation department, you may want to
create user roles for translators between specific language pairs and for reviewers in
those same language pairs; you may also refine the user roles further and subdivide
them by the type of text they translate, such as technical documentation, marketing
materials, etc.
User roles are used as a way of simplifying user access control. Rather than specifying
access permissions and restrictions for each individual user, you first create user roles for
each type of user who will be accessing the server, and you then assign one of those
roles to each of the user accounts you create. If, for example, at the start of a new
project you need to specify different access restrictions for an entire group of users, all
you need to do is change the permissions for the user role specific to that group, instead
of changing the permissions on each individual account. In the event that a specific user
is moved from one group to another, or takes on a different role for a new project (such
as going from translator to reviewer), you only need to edit that user account’s settings
and change the user role assigned to it.

PERMISSION LEVELS
Each user role is assigned a default permission level, and can optionally be assigned
permission levels for specific language. The permission level acts as an indicator of the
level of competence the user role is presumed to have: the lower the permission level
number, the greater the competence of the user. A user with a lower permission level is
able to modify or delete entries added by a user with a higher or equal level, but a user
with a higher level is not able modify or delete entries added by a user with a lower
level. Permission levels range from 1 to 50, with 1 being assigned to the Administrators
user role, and 50 being the default permission level for the generic Users user role.
When TeaM Server evaluates whether the user can modify an existing entry, it will first
check whether the user role for that user has been assigned a specific permission level
for the language of that entry. If a permission level has been assigned, it will compare
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that permission level with the permission level for the user who added or last modified
that entry; if no language specific level has been assigned, TeaM Server will use the
default permission level for the user role.
In addition to per-language permission levels, you can also restrict a user role’s access to
TeaM Server to entries with specific client tags. For example, if your company is a
translation agency working with external freelance translators on a project for a specific
customer, you can create user roles for those external translators that only have access
to the TM and TD data that belongs to that customer. Using client tags together with
user role client permissions is an easy way of creating virtual partitions in your TM and
TD for some users, while giving others (such as project managers) access to the entire
repositories.

MANAGING USER ROLES
From Manage User Roles page of the administration console, you can view the list of
existing user roles, create new roles, and modify or delete existing roles:

TO VIEW THE LIST OF USER ROLES
1.
2.
3.
4.

Log onto the administration console.
Click on the User Roles link on the menu on the left side of the page.
The Manage User Roles page appears.
The list of user roles currently defined in TeaM Server is shown in the main section
of the page.

TO ADD A NEW USER ROLE
1.
2.
3.
4.
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In the Manage User Roles page, locate the Add a new user role area.
In the User Role ID text box, type a name or identifier for the new user role.
In the Permission Level text box, type in the default permission level for the new
user role (between 1 and 50).
(Optional.) Enter one or more client tags by typing the client tag into the Clients
text box (or selecting an existing tag from the Clients dropdown list) and clicking
on the Add button.

5.

6.

(Optional.) Enter one or more language specific permission levels by selecting the
language from the Languages dropdown list and typing the permission level in the
Permission Level text box.
Click on the Create User Profile button.

TO MODIFY AN EXISTING USER ROLE
1.
2.
3.
4.

5.
6.

7.

8.

In the Manage User Roles page, locate the list of currently defined user roles.
In the Role ID column, click on the link for the user role you want to modify.
The User Role Detail page appears.
(Optional.) Modify the default permission level for the user role by entering a new
permission level in the top Permission Level text box.
(Optional.) Enter one or more client tags by typing the client tag into the Clients
text box (or selecting an existing tag from the Clients dropdown list) and clicking
on the Add button.
(Optional.) Remove one or more client tags by selecting the client tag from the list
of assigned client tags and clicking on the Remove button.
(Optional.) Enter one or more language specific permission levels by selecting the
language from the Languages dropdown list and typing the permission level in the
Permission Level text box.
(Optional.) Remove one or more language specific permissions by selecting the
language and permission level combination from the list of assigned languages and
clicking on the Remove button.
Click on the Update Details button to save the changes.

TO DELETE AN EXISTING USER ROLE
1.
2.
3.

In the Manage User Roles page, locate the list of currently defined user roles.
In the Role ID column, locate the name of the user role you want to delete.
Click on the Delete link on the left of the row for the user role you want to delete.
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USERS
Access to the translation and terminology repositories stored in TeaM Server database is
controlled through the use of user accounts. Each segment or term in TeaM Server is
tagged with the name of the user account that added or last modified it, and users
connecting to TeaM Server from Déjà Vu X Workgroup will be granted or denied access
to certain entries based on the user account they use to log onto TeaM Server (based on
the permissions assigned to user role associated with that user account).
Each user (project manager, reviewer, translator, etc.) should therefore be assigned a
unique user account and password that can be used to control the user’s access to
TeaM Server, and to track the additions and changes the user makes to the translation
and terminology entries.

MANAGING USERS
From Manage Users page of the administration console, you can view the list of
existing users, create new users, and modify or delete existing users:

TO VIEW THE LIST OF USERS
1.
2.
3.
4.

Log onto the administration console.
Click on the Users link on the menu on the left side of the page.
The Manage Users page appears.
The list of users currently defined in TeaM Server is shown in the main section of
the page.

TO ADD A NEW USER
1.
2.
3.
4.
5.
6.
7.
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In the Manage Users page, locate the Add a user area.
In the User ID text box, type a name or identifier for the new user.
In the Full name text box, type the full name of the user.
In the Password text box, type in the password for the user.
In the Confirm New Password text box, type in the password for the user.
Check the Allow logon checkbox to enable the user account.
From the User Role dropdown list, select the user role for this user.

8.

Click on the Create User button.

TO MODIFY AN EXISTING USER
1.
2.

In the Manage Users page, locate the list of currently defined users.
In the User ID column, click on the link for the user you want to modify.
The User Detail page appears.
3. (Optional.) Change the user’s full name by entering a new name in the Full Name
text box.
4. (Optional.) Enable or disable the user account by checking or unchecking the
Allow logon checkbox.
10. (Optional.) Change the user’s password by typing the new password in the New
Password and the Confirm New Password text boxes.
5. (Optional.) Change the user’s assigned user role by selecting a new role from the
User Role dropdown list.
6. Click on the Update Details button to save the changes.

TO DELETE AN EXISTING USER
1.
2.
3.

In the Manage Users page, locate the list of currently defined users.
In the User ID column, locate the name of the user you want to delete.
Click on the Delete link on the left of the row for the user you want to delete.
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TRANSLATION MEMORY
The Translation Memory in TeaM Server is a large scale repository of translated
segments. Translations can be added by a user from Déjà Vu X Workgroup by sending
single segment pairs, sending entire projects or partial project views, sending entire local
Déjà Vu X TMs, or by importing TMX files directly from the administration console.

BROWSING INTERFACE
The administration console also provides an interface for browsing the contents of the
Translation Memory by specifying certain selection criteria from which a view is
constructed, and for editing or deleting entries from the current view.

TO BROWSE THE TRANSLATION MEMORY
1.
2.
3.
4.

Log onto the administration console.
Click on the Translation Memory link on the menu on the left side of the page.
The Translation Memory page appears.
The selection criteria interface is shown in the main section of the page.

SELECTION CRITERIA
The browsing interface for the Translation Memory allows you create a view of the
Translation Memory which contains only the translated segment pairs that match certain
criteria. Each selection criteria is composed of the following elements:
•
•

•
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a Field, corresponding to a particular piece of information for the translation pair
(such as Project Name, Source User, etc.),
an equality Operator (such as =, >=, NOT =, LIKE, etc.), which specifies where
to show translation pairs where the specified field is equal to, greater than, not
equal to, etc. the specified value, and
a Value, either entered directly or selected from a dropdown list of available values
for that field

You can construct a set of criteria using the following fields:
Field

Operators

Values

Description

Project ID

=, >, >=, <,
<=, NOT =

Numeric

The ID of Déjà Vu X project from which
the translation pair was sent

Project Name

=, NOT =

Dropdown

The name of the project from which the
translation pair was sent

Browsing
Language

=, NOT =

Dropdown

The source language of the translation pair

Target
Language

=, NOT =

Dropdown

The target language of the translation pair

Source
Sentence

=, NOT =,
LIKE

Text

The source segment text

Target
Sentence

=, NOT =,
LIKE

Text

The target segment text

Client

=, NOT =,
LIKE

Text

The client tag for the translation pair

Subject

=, NOT =,
LIKE

Text

The subject tag for the translation pair

Source Date

=, >, >=, <,
<=, NOT =

Date

The date when the source segment was
added or last modified

Target Date

=, >, >=, <,
<=, NOT =

Date

The date when the target segments was
added or last modified

Source User

=, NOT =,
LIKE

Text

The name of the user who added or last
modified the source segment

Target User

=, NOT =,
LIKE

Text

The name of the user who added or last
modified the target segment

Note: The LIKE operator is similar to the standard string equality operator (=), except
that it allows the user to specify a pattern which includes wildcard characters. For
example, using the LIKE operator with the value “%computer%” will match all
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translation pairs where the specified field has a value that contains the word “computer”
anywhere inside the value. For more information, please consult the SQL Server 2005
or 2008 documentation for the LIKE operator in Transact-SQL.
Multiple selection criteria can be combined by adding new criteria and combining them
with the existing ones using the And and Or operators.

TO SPECIFY A VIEW OF THE TRANSLATION MEMORY
1.
2.
3.
4.

5.
6.

7.
8.

In the Translation Memory page, locate the selection criteria builder interface.
From the first dropdown list (with the predefined value “– Please Select –“), select
the field that corresponds to your selection criteria.
From the second dropdown list (with the predefined value “=”), select the
operator that corresponds to your selection criteria.
If the field provides a set of values, select one from the third dropdown list. If not,
enter the desired value for your selection criteria in the text box (which has a
predefined value of “(enter value)”).
Click on the Add Criterion button to add the current criterion to the list of
selection criteria.
(Optional.) Specify additional criteria, and use the rightmost dropdown list (with
the predefined value “None”) to specify the logical operator to use to combine
each new criterion.
(Optional.) Use the Up, Down and Remove links in the selection criteria list to
remove or reorder selection criteria.
Click on the Get Translations button to display the view constructed from the
specified selection criteria.

If view contains a large number of translation pairs, the administration console will split
the view into multiple pages. You can navigate through the pages by clicking on the
page numbers at the top and the bottom of the current view page, or by using the [First
Page], [Previous Page], [Next Page] and [Last Page] links at the bottom of the view.
While browsing a specific Translation Memory view, you can view and modify specific
entries in the view, as well as delete selected entries or the entire view.
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TO MODIFY A TRANSLATION MEMORY ENTRY
1.
2.
3.

4.
5.
6.
7.

In the Translation Memory page, define a view by specifying one or more
selection criteria.
Locate the translation pair you want to modify (you may need to use the navigation
links to navigate through the view).
Click on the Translation ID number on the right of the row for the translation pair
you want to modify.
The Translation Pair Detail page appears.
(Optional.) Change the client tag by typing a new client tag into the Client text
box.
(Optional.) Change the subject tag by typing a new subject tag into the Subject text
box.
(Optional.) Edit the source or target segments by editing the text in the Source
Sentence and Target Sentence text boxes.
Click on the Update Entry button to save the changes.

TO DELETE TRANSLATION MEMORY ENTRIES
1.
2.
3.
4.

In the Translation Memory page, define a view by specifying one or more
selection criteria.
Locate the translation pair(s) you want to delete (you may need to use the
navigation links to navigate through the view).
In the Delete column, check the row(s) for the translation pair(s) you want to
delete.
Click on the Delete Selected button at the bottom of the view.

TO DELETE AN ENTIRE TRANSLATION MEMORY VIEW
1.
2.

In the Translation Memory page, define a view by specifying one or more
selection criteria.
Click on the Delete all view entries button at the bottom of the view.
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TMX IMPORT
The TeaM Server administration console allows you directly import Translation Memory
eXchange (TMX) files. TMX is a standard XML-based file format meant for exchanging
Translation Memory (TM) data between translation tools. While you can import TMX
files into local Déjà Vu X TMs and send them to a TeaM Server from there, there are
some scenarios in which it may be easier or faster to import the TMX files directly into
TeaM Server’s TM.

TO IMPORT A TMX FILE
1.
2.
3.
4.
5.
6.
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In the Translation Memory page, click on the Import a TMX Translation Memory
link.
Click on the Browse button.
The Choose File to Upload window appears.
Navigate to the folder that contains the TMX file you want to import, and select the
TMX file.
Click Open.
Click on the Upload file button.
A progress page appears.
When the TMX file has finished importing, click on the Back button.

TMX EXPORT
The TeaM Server administration console allows you to export the contents of a view as
a Translation Memory eXchange (TMX) file. While TeaM Server is designed to work with
users connecting from Déjà Vu X Workgroup, there may be cases where a project
manager needs to work with a translator who does not use Déjà Vu X; in such cases,
exporting a subset of TeaM Server’s translation memory to send to the translator may be
useful.

TO EXPORT A VIEW TO A TMX FILE
1.
2.
3.

In the Translation Memory page, define a view by specifying one or more
selection criteria.
Click on the Export the view to TMX link at the top of the page.
TeaM Server will generate a TMX file with the contents of the view.
Depending on the web browser you use, you may be prompted to save the file, or
the browser will download it automatically.
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TERMINOLOGY DATABASE
The Terminology Database in TeaM Server is a large scale repository of translated
terminology. Terms can be added by a user from Déjà Vu X Workgroup by sending
single term pairs, sending project lexicons or sending entire local Déjà Vu X TDs.

BROWSING INTERFACE
The administration console also provides an interface for browsing the contents of the
Terminology Database by specifying certain selection criteria from which a view is
constructed, and for editing or deleting entries from the current view.

TO BROWSE THE TERMINOLOGY DATABASE
5.
6.
7.
8.

Log onto the administration console.
Click on the Terminology Database link on the menu on the left side of the page.
The Terminology Database page appears.
The selection criteria interface is shown in the main section of the page.

SELECTION CRITERIA
The browsing interface for the Terminology Database allows you create a view of the
Terminology Database which contains only the translated term pairs that match certain
criteria. Each selection criteria is composed of the following elements:
•
•

•
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a Field, corresponding to a particular piece of information for the translation pair
(such as Target Language, Source Lemma, User, etc.),
an equality Operator (such as =, >=, NOT =, LIKE, etc.), which specifies where
to show translation pairs where the specified field is equal to, greater than, not
equal to, etc. the specified value, and
a Value, either entered directly or selected from a dropdown list of available values
for that field

You can construct a set of criteria using the following fields:
Field

Operators

Values

Description

Browsing
Language

=, NOT =

Dropdown

The source language of the term pair

Target
Language

=, NOT =

Dropdown

The target language of the term pair

User

=, NOT =,
LIKE

Text

The name of the user who added or last
modified the term pair

Source
Lemma

=, NOT =,
LIKE

Text

The source segment text

Target
Lemma

=, NOT =,
LIKE

Text

The target segment text

Date

=, >, >=, <,
<=, NOT =

Date

The date when the term pair was added or
last modified

Note: The LIKE operator is similar to the standard string equality operator (=), except
that it allows the user to specify a pattern which includes wildcard characters. For
example, using the LIKE operator with the value “%computer%” will match all
translation pairs where the specified field has a value that contains the word “computer”
anywhere inside the value. For more information, please consult the SQL Server 2005
or 2008 documentation for the LIKE operator in Transact-SQL.
Multiple selection criteria can be combined by adding new criteria and combining them
with the existing ones using the And and Or operators.

TO SPECIFY A VIEW OF THE TERMINOLOGY DATABASE
1.
2.
3.

In the Terminology Database page, locate the selection criteria builder interface.
From the first dropdown list (with the predefined value “– Please Select –“), select
the field that corresponds to your selection criteria.
From the second dropdown list (with the predefined value “=”), select the
operator that corresponds to your selection criteria.
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4.

5.
6.

7.
8.

If the field provides a set of values, select one from the third dropdown list. If not,
enter the desired value for your selection criteria in the text box (which has a
predefined value of “(enter value)”).
Click on the Add Criterion button to add the current criterion to the list of
selection criteria.
(Optional.) Specify additional criteria, and use the rightmost dropdown list (with
the predefined value “None”) to specify the logical operator to use to combine
each new criterion.
(Optional.) Use the Up, Down and Remove links in the selection criteria list to
remove or reorder selection criteria.
Click on the Get Translations button to display the view constructed from the
specified selection criteria.

If view contains a large number of term pairs, the administration console will split the
view into multiple pages. You can navigate through the pages by clicking on the page
numbers at the top and the bottom of the current view page, or by using the [First
Page], [Previous Page], [Next Page] and [Last Page] links at the bottom of the view.
While browsing a specific Terminology Database view, you can view and modify
specific entries in the view, as well as delete selected entries or the entire view.

TO MODIFY A TERMINOLOGY DATABASE ENTRY
1.
2.
3.

4.
5.
6.
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In the Terminology Database page, define a view by specifying one or more
selection criteria.
Locate the term pair you want to modify (you may need to use the navigation links
to navigate through the view).
Click on the Terminology ID number on the right of the row for the translation
pair you want to modify.
The Term Pair Detail page appears.
(Optional.) Edit the source or target terms by editing the text in the Source Lemma
and Target Lemma text boxes.
(Optional.) Edit the source and target term attributes by typing or selecting new
attribute values in the Attributes area.
Click on the Update Entry button to save the changes.

TO DELETE TERMINOLOGY DATABASE ENTRIES
1.
2.
3.
4.

In the Terminology Database page, define a view by specifying one or more
selection criteria.
Locate the term pair(s) you want to delete (you may need to use the navigation
links to navigate through the view).
In the Delete column, check the row(s) for the term pair(s) you want to delete.
Click on the Delete Selected button at the bottom of the view.

TO DELETE AN ENTIRE TERMINOLOGY DATABASE VIEW
1.
2.

In the Terminology Database page, define a view by specifying one or more
selection criteria.
Click on the Delete all view entries button at the bottom of the view.
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ATTRIBUTES
The Terminology Database in TeaM Server supports assigning user-defined attributes to
lemmas. Attributes are custom fields of a certain type (for example, numbers, text,
enumerated values, etc.) that you can add to lemmas, assigning a specific value to each
lemma. In general, attributes are used to store additional information about a lemma
(such as definition, part of speech, context, etc.) that may be useful for the translator to
see, but is not used by Déjà Vu X Workgroup when searching for terms in the TeaM
Server Terminology Database.
TeaM Server allows you to define the attributes that are stored in the Terminology
Database, so that users connecting to it from Déjà Vu X Workgroup can view and edit
attribute values for the terminology they search for or add.
TeaM Server supports five types of attribute:
Attribute Type

Description

Integer

Numbers

String

Text

Boolean

Yes/no values

Date

Dates

Enumerated

Values from a predefined list

Note: Enumerated values (categories in Déjà Vu X) are a special type of attribute where
the possible values are taken from a list of predefined values.
Attribute types have both a name, used to when displaying the attribute to the user, and
a token, used internally to identify the attribute (in particular when matching attributes
from Déjà Vu X local TDs to attributes in TeaM Server). The name can be changed at
any time, but the token should not be edited once instances of the attribute have been
added to lemmas in the TeaM Server Terminology Database. Each entry in the list of
predefined values for an Enumerated attribute also has a name and a token; as with
attribute types, the name can be changed freely but the token should not be modified
once it has been used.
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TO VIEW THE LIST OF ATTRIBUTE TYPES
1.
2.
3.
4.

Log onto the administration console.
Click on the Terminology Attributes link on the menu on the left side of the page.
The Manage Terminology Attribute Types page appears.
The list of terminology attribute types currently defined in TeaM Server is shown in
the main section of the page.

TO ADD A NEW ATTRIBUTE TYPE
1.
2.
3.
4.
5.

6.

In the Manage Terminology Attribute Types page, locate the Add a terminology
attribute type area.
In the Name text box, type the name of the new attribute type.
In the Token text box, type the internal token for the new attribute type.
In the Type dropdown list, select the data type for the new attribute type.
(Optional.) If you selected Enumerated as the data type for the new attribute type,
you can add a list of predefined values for the attribute. For each predefined value,
type the name of the value into the Value name text box, the token in the Value
token text box, and click on the Add button to add the value to the list of
predefined values.
Click on the Create Terminology Attribute Type button.

TO MODIFY AN EXISTING TERMINOLOGY ATTRIBUTE
1.
2.
3.
4.

In the Manage Terminology Attribute Types page, locate the list of currently
defined attribute types.
In the ID column, click on the link for the attribute type you want to modify.
The Terminology Attribute Type Detail page appears.
(Optional.) Change the attribute type’s display name by entering a new name in
the Name text box.
(Optional.) If the data type of the attribute is Enumerated, add one or more
predefined values by typing client tags by typing the name of the value into the
Value name text box, the token in the Value token text box, and click on the Add
button.
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5.

6.

(Optional.) If the data type of the attribute is Enumerated, remove one or more
predefined values by selecting the predefined value from the list of predefined
values and clicking on the Remove button.
Click on the Update Details button to save the changes.

TO DELETE AN EXISTING TERMINOLOGY ATTRIBUTE
1.
2.
3.
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In the Manage Terminology Attribute Types page, locate the list of currently
defined attribute types.
In the Name column, locate the name of the attribute type you want to delete.
Click on the Delete link on the left of the row for the attribute type you want to
delete.

USING TEAM SERVER WITH DÉJÀ VU X WORKGROUP
This chapter describes how to connect to TeaM Server from Déjà Vu X Workgroup
projects, and how to export data from local Déjà Vu X TMs and TDs.

OVERVIEW
TeaM Server is meant to be used primarily by project managers, reviewers and
translators working with Déjà Vu X Workgroup. The use TeaM Server from Déjà Vu X
Workgroup designed to be almost entirely transparent, providing users with the same
advanced leveraging capabilities whether working with local TMs and TDs or TeaM
Server ones.
All of the translation and QA features of Déjà Vu X Workgroup (such as Scan, Lookup,
Pretranslate, Assemble, AutoSearch, AutoSend, AutoCheck, etc.) work exactly when
connected to a TeaM Server as when using local TMs and TDs.

CONNECTING TO TEAM SERVER FROM DÉJÀ VU X
Connecting to TeaM Server from Déjà Vu X Workgroup is simply a matter of using the
TeaM Server in the same way you would use a local TM or TD in Déjà Vu X.

PROJECTS
Connecting a Déjà Vu X Workgroup project to TeaM Server involves assigning a TeaM
Server instance to the list of TMs or TDs for a project.

TO CONNECT AN EXISTING PROJECT TO TEAM SERVER
1.
2.
3.

4.

Open Déjà Vu X Workgroup.
Select the File > Open menu option.
In the Open dialog, navigate to the folder that contains the project you want to use
with TeaM Server, select the project, and click on the Open button.
The Déjà Vu X project opens.
Select the Project > Properties menu option.
The Project Properties window appears.
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5.
6.
7.
8.

9.
10.
11.
12.
13.
14.

Select the Databases tab.
From the Target language dropdown list, select the target language for which you
want to associate a TeaM Server Translation Memory or Terminology Database.
Click on the Add Server TM button.
The TeaM Server Login window appears.
In the Server URI text box, enter the address of the TeaM Server you want to
connect to. If you are connecting to a TeaM Server over the Internet, the URI
should have the form http://teamserver.mycompany.com/TeaMServer/. If you are
connecting to a TeaM Server on the local network using the Binary TCP protocol,
the URI should have the form tcp://teamserver/.
In the User text box, enter the user ID assigned to you by the TeaM Server
administrator.
In the Password text box, enter the password assigned to you by the TeaM Server
administrator.
(Optional.) Check the Remember password checkbox to have Déjà Vu X
Workgroup remember your login information.
Click on the OK button.
Click on the Add Server TDB button, and repeat steps 8 to 12.
Click on OK to close the Project Properties button.

TO CONNECT A NEW PROJECT TO TEAM SERVER
1.
2.
3.
4.
5.
6.
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Open Déjà Vu X Workgroup.
Select the File > New menu option.
The New File window appears.
In the New File window, select Project and click on the OK button.
The New Project Wizard appears.
Follow the New Project Wizard instructions to create a new project, specifying the
name and location of the project and the source and target languages.
In the Specify a Translation Memory step, click on the Add Server TM button.
The TeaM Server Login window appears.
In the Server URI text box, enter the address of the TeaM Server you want to
connect to. If you are connecting to a TeaM Server over the Internet, the URI
should have the form http://teamserver.mycompany.com/TeaMServer/. If you are
connecting to a TeaM Server on the local network using the Binary TCP protocol,
the URI should have the form tcp://teamserver/.

7.
8.
9.
10.
11.
12.
13.

14.
15.
16.
17.
18.
19.

In the User text box, enter the user ID assigned to you by the TeaM Server
administrator.
In the Password text box, enter the password assigned to you by the TeaM Server
administrator.
(Optional.) Check the Remember password checkbox to have Déjà Vu X
Workgroup remember your login information.
Click on the OK button.
Click on the Next button.
In the Specify a Terminology Database step, click on the Add Server TDB button.
The TeaM Server Login window appears.
In the Server URI text box, enter the address of the TeaM Server you want to
connect to. If you are connecting to a TeaM Server over the Internet, the URI
should have the form http://teamserver.mycompany.com/TeaMServer/. If you are
connecting to a TeaM Server on the local network using the Binary TCP protocol,
the URI should have the form tcp://teamserver/.
In the User text box, enter the user ID assigned to you by the TeaM Server
administrator.
In the Password text box, enter the password assigned to you by the TeaM Server
administrator.
(Optional.) Check the Remember password checkbox to have Déjà Vu X
Workgroup remember your login information.
Click on the OK button.
Click on the Next button.
Follow the rest of the New Project Wizard instructions to finish creating the new
project.

Once a project is connected to TeaM Server, Déjà Vu X Workgroup will attempt to
connect to TeaM Server every time the project is opened. Upon opening a project that
connects to TeaM Server, Déjà Vu X will display the TeaM Server Login window and
will prompt you enter your login details. If you chose to have Déjà Vu X remember your
password, you will only need to click on the OK button to log in; otherwise, you will
need to enter your password in the Password text box and then click on the OK button.
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TRANSLATION MEMORIES
As part of the migration to TeaM Server, or when working with Translation Memories
(TMs) from users without access to TeaM Server, you may need to export data from a
local TM to the TeaM Server. Using Déjà Vu X Workgroup, you can open a local Déjà
Vu X TM and export all or part of its contents to TeaM Server.

TO EXPORT A DÉJÀ VU X TM TO TEAM SERVER
1.
2.
3.

4.
5.
6.
7.
8.

9.
10.
11.
12.
13.
14.

15.
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Open Déjà Vu X Workgroup.
Select the File > Open menu option.
In the Open dialog, navigate to the folder that contains the TM you want to use
export to TeaM Server, select the TM, and click on the Open button.
The Déjà Vu X TM opens.
Select the File > Export > File or Database menu option.
The Translation Memory Export Wizard opens.
Click on the Next button.
In the Specify Data Format list, select TeaM Server.
Click on the Next button.
In the Server URI text box, enter the address of the TeaM Server you want to
export the TM to. If you are connecting to a TeaM Server over the Internet, the
URI should have the form http://teamserver.mycompany.com/TeaMServer/. If you
are connecting to a TeaM Server on the local network using the Binary TCP
protocol, the URI should have the form tcp://teamserver/.
In the User text box, enter the user ID assigned to you by the TeaM Server
administrator.
In the Password text box, enter the password assigned to you by the TeaM Server
administrator.
Click on the Next button.
In the Available languages list, select the languages you want to export and click
on the Add button to add them to the Export languages list.
Click on the Next button.
(Optional.) In the Filtering conditions text box, enter a filtering expression to
specify the subset of the TM entries that you want to export.
Note: Consult the Déjà Vu X Workgroup for details on how to construct a filtering
expression.
Click on the Next button.

16. Click on the Finish button.
The Translation Memory Export Wizard displays a progress bar.
17. When the export is complete, click on the Close button.
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TERMINOLOGY DATABASES
As part of the migration to TeaM Server, or when working with Terminology Databases
(TDs) from users without access to TeaM Server, you may need to export data from
local TDs to the TeaM Server. Using Déjà Vu X Workgroup, you can open a local Déjà
Vu X TD and export all or part of its contents to TeaM Server.

TO EXPORT A DÉJÀ VU X TD TO TEAM SERVER
1.
2.
3.

4.
5.
6.
7.
8.

9.
10.
11.
12.
13.
14.

15.
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Open Déjà Vu X Workgroup.
Select the File > Open menu option.
In the Open dialog, navigate to the folder that contains the TD you want to use
export to TeaM Server, select the TD, and click on the Open button.
The Déjà Vu X TD opens.
Select the File > Export > File or Database menu option.
The Terminology Database Export Wizard opens.
Click on the Next button.
In the Specify Data Format list, select TeaM Server.
Click on the Next button.
In the Server URI text box, enter the address of the TeaM Server you want to
export the TM to. If you are connecting to a TeaM Server over the Internet, the
URI should have the form http://teamserver.mycompany.com/TeaMServer/. If you
are connecting to a TeaM Server on the local network using the Binary TCP
protocol, the URI should have the form tcp://teamserver/.
In the User text box, enter the user ID assigned to you by the TeaM Server
administrator.
In the Password text box, enter the password assigned to you by the TeaM Server
administrator.
Click on the Next button.
In the Available languages list, select the languages you want to export and click
on the Add button to add them to the Export languages list.
Click on the Next button.
(Optional.) In the Filtering conditions text box, enter a filtering expression to
specify the subset of the TD entries that you want to export.
Note: Consult the Déjà Vu X Workgroup for details on how to construct a filtering
expression.
Click on the Next button.

16. Click on the Finish button.
The Terminology Database Export Wizard displays a progress bar.
17. When the export is complete, click on the Close button.
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